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Abstract

The DA14585 loT Sensors Reference Application can be compiled using the ARM GCC compiler
and Dialog Semiconductor provides an example of Eclipse project to how to accomplish this. This
document describes the required steps to download and compile this project.
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1 Terms and Definitions

BLE Bluetooth Low Energy

CDT C/C++ Development Tooling
GAP Generic Access Profile

GAPC Generic Access Profile Controller
GAPM Generic Access Profile Manager
GATT Generic Attribute Profile

IDE Integrated Development Environment
loT Internet of Things

MSK Multi Sensor Development Kit
PC Personal Computer

RAM Random Access Memory

SOC System on Chip

2 References

[1] UM-B-096, DA14585 IoT Multi Sensor Development Kit Software Reference Applications, User

Manual, Dialog Semiconductor.

[2] UM-B-095, DA14585 IoT Multi Sensor Development Kit Hardware Design, User Manual, Dialog

Semiconductor.

[3] UM-B-057, Smart Snippets™ Studio User Guide, User Manual, Dialog Semiconductor.

Application Note

Revision 1.1

17-Jan-2022

CFRO014

3of 24

© 2022 Renesas Electronics



LENESAS

Compiling DA14585 IoT Sensors Reference Company Confidential
Application with Eclipse/GCC

AN-B-064

3 Introduction

Dialog Semiconductor's loT multi sensor development kit (MSK) [1], a compact development Kit,
offers 15 degrees of freedom accompanied by five software reference applications [2] and
incorporates versatile sensor management with cloud applications. The loT MSK is based on
DA14585 Bluetooth Low Energy (BLE) system-on-chip (SoC) and a number of motion and
environmental sensors.

The provided reference applications can be compiled with Keil yVision and ARMCC toolchain which
is the recommended development environment. Many developers would like to use the free GCC
compiler/linker and Dialog has provided an example Eclipse/GCC project port of the IoT Sensors
Reference Application. For more details on this application refer to section 5 of [1].

This document describes how to setup the environment, download, compile, and debug the l1oT
Sensors Reference Application using Eclipse/GCC. It is required that users should already be
familiar with Eclipse CDT environment.

4 Installation

4.1 Prerequisites

A Personal Computer running Windows 7 or Windows 10.
SmartSnippets Studio v2.0.5.

A DA14585 loT MSK.

A Communication Interface Board.

4.2 SmartSnippets™ Installation

Dialog's SmartSnippets™ Studio is a royalty-free software development platform for Smartbond ™
devices. For detailed information on SmartSnippets™ Studio refer to [3].

SmartSnippets™ Studio contains:

e SmartSnippets™ IDE: Eclipse CDT based IDE with pre-configured plugins to provide the
build/debug environment

e SmartSnippets™ Toolbox which covers all software development requirements, including:
o programming and loading firmware into SRAM, OTP, and Flash
o power profiling

e SmartSnippets™ documentation.

The SmartSnippets™ IDE is enabled by an on-board J-Link debugger from SEGGER. This offers
standard debug capabilities such as single stepping, setting breakpoints, software download, and
many more. For more details on the debugger capabilities, visit https://www.segger.com.

The installation procedure for SmartSnippets™ Studio is described in [3]. A summary of the steps is
given here:

1. Navigate to Dialog's support portal https://support.dialog-semiconductor.com and choose
Connectivity > Products > DA14585 > Software&Tools > Tools (Figure 1) and download the
latest 2.0.x version of SmartSnippets™ Studio.

2. Run the SmartSnippets™ Studio installer (.msi). Several required tools are automatically installed
and others need to be manually downloaded and installed.
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3. Select the already installed version of SEGGER J-Link GDB server or install the latest version
(Figure 2) and click "Next".

4. Select the destination folder (Figure 3) for the SmartSnippets™ Studio and click"Next". The
default installation location C:\DiaSemi is recommended.

The SmartSnippets™ Studio will be installed. Please Note that some software components during
installation may require administrator privileges.

I I Home Connectivity Modules Ref designs Partners Forums FAQ Guide
<//
e —

n)u R

DA14585

Date Version Title \ Rocorvn Additional Download
pdate licensing
[ 1 notifications  info

) B

Figure 1: Download SmartSnippets™ Studio

ﬁ Dialeg SmartSnippets Studio (v2.0.6.1164) Setup
SEGGER J-Link GDB Server d |
Select SEGGER J-Link GDB Server, Ia| o

(® Select one of the available SEGGER J-Link GDB Server installations {min version 4.92)

C:\Program Files (x86)\SEGGER VLink V&14h

() Press Next to install recommended version J-Link Software vé. 14h

Please specify existing SEGGER 1-Link software installation:

IC:'l, Browse

Figure 2: Use Pre-Existing J-Link
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ﬁ Dialeg SmartSnippets Studio (v2.0.6.1164) Setup *
Destination Folder d |
Click Change to select a different installation folder, |I q Q
Install Dialog SmartSnippets Studio (v2.0.6.1164) to:
IC:\,DiaSemi‘l,
| Back [ mMext | | cancel |

Figure 3: Select SmartSnippets™ Studio Installation Directory
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4.3 Download the DA14585 IoT MSK Eclipse/GCC Example

Like SmartSnippets™ Studio, the Eclipse/GCC example can be downloaded from Connectivity >
Products > DA14585 > Reference Designs > DA14585 IoT Multi Sensor Development Kit
(Figure 4) in the support portal.

The filename of the example is DA14585 IOT MULTI SENSOR DK GCC EXAMPLE v6.160.x.zip and
includes only the GCC port of the software. The release folder v6.160.x included in the zipped file
should be extracted by users and placed in a convenient path.

d d Ia |O Home Connectivity : Modules Ref designs Partners Forums FAQ Guide
DA14585 \

>
DA 14885 IoT Multi Sensor Development Kit

~
/ Control your cloud-based systems with Alexa and the world's lowest
4

power 15-DOF wireless sensor module
IE‘- 4585 loT M nsor Development Kit I

Figure 4: Downloading Eclipse/GCC Example
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5 Importing the Eclipse/GCC Project
1. Start SmartSnippets™ Studio by clicking on the icon.

The SmartSnippets™ Studio will ask the workspace directory. Select the root directory of the project
that is named v6.160.x (for example, v6.160.4.15, Figure 5).

¢Jdialog

SEMICONDUCTOR

SmartSnippets™ Studio

v2.0.5.1097

@ Eclipse Launcher

Select a directory as workspace
SmartSnippets Studio v2.0.6.1164 uses the workspace directory to store its preferences and development artifacts.

v I[ Browse...

[[] Use this as the default and do not ask again

[ ok ] cance |

Figure 5: Starting SmartSnippetsTM Studio and Selecting Workspace
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2. Next, when the dialog asking for a workspace type pops up, select "Take no action".

(1] X

Config.xml could not be found.
Please specify how the selected workspace should be treated.

(O Treat as DA1468x 1.0.4 SDK
(O Treat as DA1458x 5.0.3 SDK
I (® Take no action I

Figure 6: Selecting Workspace Type

3. To proceed, a number of development tools should be installed (Figure 7), or their installation
directory should be given (Figure 8) if they are already installed.

(®) SOK Tools Installer | x

SDK Tools Summary

Welcome to the installation of required SDK tools

The selected SDK has been tested by Dialog with the specificversions of the tools listed below under column ‘Required version for this SDK.
Please note that the required versions for a specific SDK may be different than the default versions bundled in the SmantSnippets Studio installer
Dialog strongly recommends using the required versions; using different versions may cause unexpected side effects.

Tool Name Requiredversion forthis 8 Installed version Found installed in pathis) Required version fou
Segger Ozone 232 - - x
J-Link software package components 6.30h 6.14h C:\Program Files (xB6\SEGGER\LIn k3
GMU Tools for ARM Embedded Processo 7-2018-g2 = = ®
SystemView 242 - - ®

=< Back Finish Cancel

Figure 7: Tools to Be Installed
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@ SOK Tools Installer

Company Confidential

Segger Ozone installation
“You can skip the installation by pressing the “Next” button

Segger Ozone version 2.32 could not be found.

(@) Required version is already installed
(O Download and install the required version

Please specify the installation folder.

|C.\Pm;¢am Files\SEGGER\Ozone V2.581 | | Browse | v

< Back

Mexd =

Finish

Cancel

@ SOK Tooks Installer

Segger J-Link soff ck

J-Link software package components version 6.30h could not be found.

(®) Required version is already installed
(O Install the required version

Please specify the installation folder:

|C.‘FmgramFilesfw&)\SEGGERULink_VEHII || Browse |V

<Back

Next >

Finish

o X

Cancel

(@ SOK Tools Installer

Segger SystemView installation
You can skip the installation by pressing the "Neat” button

version 2.42 could not be found.
@) Required version is already installed

() Download and install the required version

Please specify the installation folder:

CAProgram Files (x86\SEGGER\SystemView_V242 | | Browse | V

<Back

Finish

Cancel

Figure 8: Set SEGGER Ozone & J-Link Installation Folder
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4. The SDK Tools Installer will prompt for the installation of GCC and the default version 7-2018-
g2 is recommended to download. Select Download and installed the required version and

click Download (Figure 9). After the download is complete the green completion mark is shown
and the Next may be pressed to continue (Figure 9).

@ SDK Toals Installer

[m] X

GNU Teols for ARM Embedded Processors installation

GNU Toaols for ARM Embedded Processors version 7-2018-g2 could not be found.

() Required version is already installed

Download and install the required version
Download
= Back Next = Finish Cancel

@ SDK Tools Installer m| *

GNU Tools for ARM Embedded Pr

GNU Tools for ARM Embedded Processors version 7-2018-g2 could not be found.

(O Required version is already installed
(®) Download and install the required version

Download

GMNU Tools for ARM Embedded Processors successiully installed in folder V
C\DiaSemi\SmartSnippetsStudio2.0.6\GCC\7-2018-q2

= Back Finish Cancel

Figure 9: GCC Tools Installation
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5. The SmartSnippets™ Studio environment will now appear. Users should click the IDE icon to

start the Eclipse CDT IDE (Figure 10).

@ 6160415 - Welcorne - SmartSnippets Studio v2.0.6.1164 - o x
File Edit MNavigate Search Project Run Window Help
O~ @i@-%-i,-BiLiBib-F- o [Buick Access] | 2 | (@)
0 @ Welcome 13 =8 g
m
dialog
SmartSnippets™ Studio

SELECT YOUR SDK ROOT DIRECTORY HERE

|c \Bluetoothidev_codels. 160.4.15 |

SELECT THE DEVICE ON YOUR DEVELOPMENT BOARD

ALL 4 Detect connected device(s)

SmartSnippets Toolbox Segger Systemview Segger Ozone RF Master
Resources
API DOCUMENTATION SOFTWARE RESOURCES PRODUCT DOCUMENTATION FORUMS
Import test projects in workspace DA14585 SmartBond Forums
DA14586
=
Figure 10: Starting the IDE
Application Note Revision 1.1 17-Jan-2022
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6. Now the Eclipse CDT IDE will open (Figure 11). In the left-side window there are no projects

listed, so the next step is to insert the project example.

@ iot_585_ref - C/C++ - SmartSnippets Studio v2.0.5.1097 — [m] X
File Edit Source Refactor MNovigate Search Project Run  Window Help
OD-HE B-&-HisSig 8- H-C-i@ % - W L BEENH-T-we-2- [quickAccess| || 5% | @ (B 4
© | B Project Bxplorer 3¢ A% v=08 =8 So.x D B. =8
An outlin t labl
ems | Tasks ) Console 53 Properties = B [} DebuggerConsole &7 B-=08
= E v [ ~ Noconsoleto display at this time.
Ne consoles to display at this time.
0 items selected
Figure 11: Eclipse CDT IDE without project
Application Note Revision 1.1 17-Jan-2022
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7. Toinsert an existing project, click File > Import. The Import window now will open and users

should select "Existing Projects into Workspace" from the root tree "General" (Figure 12) and
then click "Next".

[11] Import [m] X
Select
P
Create new projects from an archive file or directory. H

Select an import wizard:

w [ General
. Archive Fi
L Fle em
[T] Preferences
(=} Projects from Folder or Archive

> = C/Css

3 [ Install

> (= Run/Debug

» [= Team

@ < Back Next > Finish Cancel

Figure 12: Insert Existing Project into Workspace
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8. A window will appear and users should choose "Browse" next to "Select root directory", then
select the root directory of v6.160.4.15 (Figure 13), and press OK.

Application Note

Qir't‘:r:

Import Projects
Select a directory to search for existing Eclipse projects.

I (®) Select root directory: i s Browse...
O Select archive file: Browse...
Projects: | Browse For Folder

Select root directory of the projects to import | Select All
| Deselect Al
v g This PC A W Refresh
> _J 3D Objects b
> [ Desktop
> [£] Documents
> ¥ Downloads
> D Music
Options > [&] Pictures
[ Searc > [ Videos
[ Copy| v 5 OSDisk (C:)
[JHide > [ am
3 v Bluetooth
otk > || android
[JAdd > ble_template New...
build_logs -
kin = - A [Select..,
Folder: iot_S85_ref l
Make New Folder [Coc ] cancel
@ [ <Back | Nea> Fimsh | [ Cancel

Figure 13: Select Project Root Directory
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9. Alist of projects compatible with Eclipse will appear, and users should only select the iot585
project by ticking the selection box (Figure 14) and then press "Finish".

Application Note

@ Import
Import Projects
Select a directory to search for existing Eclipse projects.

(®) Select root directory:

() Select archive file:

Projects:

@ 0t585 (C:\Bluetooth\dev_code\v6.160.4.15\projects\target_apps\i|

< >

Options
[[JSearch for nested proj
[[] Copy projects into workspace

[[JHide projects that already exist in the workspace

Working sets
[J Add project to working sets

king sets;

® < Back

Next >

C:\Bluetooth\dev_code\v6.160.4.15 w | .

Browse...

Select All
Deselect All

Refresh

New...

Select...

Figure 14: Selecting the iot585 Project
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10. After Eclipse imports the project, the iot585 project will appear in the Project Explorer window
(Figure 15).

@ iot 585 ref - C/Co+ - SmartSnippets Studio v2.0.5.1

File Edit Source Refactor Mavigate Search Project Run Window Help
D" WA ®-R-RBiE-S-E-F-iBin|SiH-@-W-idL-iEEH-F v <~ [QuickAccess] || 18 | @ [
(1] [25 Project Explorer 3 = 8 =8 ZEoxfio®» =0

-

(1)

&
v iﬂ?ﬁ An outline is not available.

> 1;’ Binaries

> B Includes

> (R akDe9ls

> R bmedd0

> (R bmils0

> R bsec_lib

> [ driver_adaptation_layer

> R iemd2e

> sdk_app

> B sdk_app_api

» ( sdk_arch

> R sdk_arch_api

> R sdk_ble

> (R sdk_boot

> [ sdk_driver

> R sdk_driver_api

> (B sdk_profiles

> B sensor_calibration

> [ sensors_interface

> R user_app

» ([ user_config

3 R user_platform

» R user_profiles

> B user_sensors 18 Problems & Tasks ) Consale 12 |[T] Properties O G| Rl = & B~-8-= 0O

> (R user_sfl - -
> G veno10 COT Build Console [iot585]

» (R whup_adapter
> (= Debug

_'| Jlinklog

|5 makefiletargets

: Build Project: (0%) il

Figure 15: iot585 Project Imported
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6 Building the Project

After the abovementioned steps, an existing project is imported into Eclipse CDT environment but it
is not built. To build the project, click the "build" icon on the menu bar (Figure 16). The progress of
building the project is shown in the bottom console window.

@ ict_585_ref - C/C+ - SmartSnippets Studio v2.0.5.1097 - o *
File Edit Source Refactor Mavigate Search Project Run Window Help
iD-HelsfA-Rig-8-8-G-iBin|Lik-@ A i@P-BFEDH-F oD [Quckacces] ] 8 | @ [6E
@ & Project Explorer 23 A = o =0 gEon e @ =0
~ 5 iotses
» 4 Binaries in outline is not available.
> R Includes
5 G ak0391s
5 (R bmesad
> (R bmiled
> (B bsec_lib
» (R driver_adaptation _laye:
> R iema2in
> P sdk_spp ] Project
» (PR sdk_app_api -
> [ sdk_arch 'ﬁ Building project...
> [P sdk_arch_api 4
G sble | —
> @8 sdl:_bo.nl Imveking Command: make pre-build main-build
> [ sdk_driver
> R sdk_driver_spi
> BB sdk_profiles [ Always run in background
» (R sensor_calibration
» [ sensors_interface Run in Background Cancel Details »>
> B userspp
» (R user_config
» [ user_platform
> [P user_profiles
> (R user_sensors
sfl s : : = — -
:izﬁm i Problems | Tasks B Console 22 |[T] Properties O 48 BH-kmB-9r= 0
5 (R whup_adapter COT Build Console [iot585)
» (= Debug Building file: C:/Bluetcoth/dev_code/bitbucket/I0TS85 Phase 2/iot_585_ref/projects/target_apps/iot/iot_585/src/user_ "
| jlinklog Inveking: GNU ARM Cross C Compiler
¥ makefile.targets arm-none-eabi-goc -mcpuscortex-m@ -mthumb -Os -fmessage-length=@ -fsigned-char -ffunction-sections -fdata-sections
Finished building: C:/Bluetocoth/dev_code/bitbucket/IOTSES Phase 2/iot_S585_ref/projects/target_apps/iot/iot_585/src/u
Building file: C:/Bluetcoth/dev_code/bitbucket/IOT585 Phase 2/iot_585_ref/projects/target_apps/iot/iot_S85/src/user_
Invoking: GMU ARM Cross € Compiler
arm-none-eabi-gec -mcpu=cortex-m@ -mthumb -Os -fmessage-length=@ -fsigned-char -ffunction-sections -fdata-sections
Finished building: C:/Bluetooth/dev_code/bitbucket/IOTS85 Phase 2/iot_S585_ref/projects/target_apps/iot/iot_585/src/u
Building file: C:/Bluetooth/dev_code/bitbucket/IOT585 Phase 2/iot_585_ref/projects/target_apps/iot/iot_S85/src/user_
Invoking: GMU ARM Cress € Compiler
arm-none-eabi-gec -mcpu=cortex-m@ -mthumb -0s -fmessage-length=@ -fsigned-char -ffunction-sections -fdata-sections
v
< >
: Build Project: (21%) -3
Figure 16: Build the Project
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At the end of the building procedure (Figure 17), output files iot585.elf and iot585.hex are
generated. These files are located inside the folder
projects\target apps\iot\iot 585\Eclipse\Debug. The iot585.elf is the linker output and can
be used for debugging. The iot585.hex is the stripped binary and will be used to create the multi-

image file that can be burned directly into flash.

(@ iot_585_ref - C/C++ - SmartSnippets Studio v2.0.5.1097
File Edt Source Refactor Mavigate Search Project Run  Window Help

s fhd .E)v&v_,wgﬁjvéjv_;uvgvgagk Pl @ Q™

[1] [ Project Explorer 52
~ [55 iot585
> t-." Binaries
> mi Includes
(R ak09915
» [ bmesS0
» (A bmile0
> R bsec_lib

> [ remd2fioc

> (R sdk_app

> R sdk_app_api
(R sdk_arch

> R sdk_arch_api
> R sdk_ble

R sdk_boot

(R sdk_driver

> R sdk_driver_api
> R sdk_profiles

> R user_app
> R user_config
(R user_platform
> R user_profiles
> (R user_sensors
> R user_sfl
(R venk010
» [ whup_adapter
> (= Debug

1 jlink.log

[ makefiletargets

Application Note

(R driver_sdaptation_layer

R sensor_calibration
» [ sensors_interface

i1 Problems | Tasks | B Console 2 |[[] Properties

p —
[COT Build Conscle [iot585]

Invoking: GNU ARM Cross Create Flash Image
arm-none-eabi-objcopy -0 ihex "iot585.e1f" “iot585.hex”
Finished building: iot585.hex

Invoking: GNU ARM Cross Print Size
arm-none-eabi-size --formats=berkeley "iot585.elf"
text data bss dec hex filename
GR87E 576 12164 73618 1192 iot585.elf
Finished building: iot585.siz

14:34:11 Build Finished (took 2m:135.531ms)

<

Figure 17: Building Finished
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7 Debugging

For the purpose of debugging, click the Debug icon and then select the RAM_DA14585 debug
configuration (Figure 18).

@ ot _585_ref - C/Ce+ - SmartSnippets Studio v2.0.5.1097
File Ed#t Sowrce Refactor Mavigate Search Project Fun  Window Help
w7 B -Big S @-Q Prilie | &k fifl~ril~w o
@ &5 Project Explorer 11 I RTRAMDA 4565
w [ iots8s Debug As ?
> il Includes Debug Configurations...
> P akDoes
> R bmesZ)
> CB bmilsd
5 G bsec lib
» f driver_adaptation_leyer
> CB iemd2be
> G sdk_app
> R sdk_app_api
+ R sdk_arch
5 G sdic_arch_api
> R sdk_ble
> CB sdk boot
> R sdk_driver
R sdlk_deiver_api
> sdk_profiles
» f sensor_calibration
3 R sensors_interface
v userapp
» R user_config
3 user_platform
> B user_profiles
> R user_sensors
> ot usersfl
> G venko10

Organize Favorites...

» (R whup_adapter
+ (= Debug
[H) makefiletangets

Figure 18: Start Debugging
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Accept it when Eclipse asks to open the Debug perspective and then the Debug view will open.
Press the Resume button to start running the program (Figure 19).

0 iot_585_ref - Debug - iot585/sdk_arch/arch_main.c - SmartSnippets Studio v2.0.5.1097 - a X
File Edit Source Refactor Navigate Search Project Pydev Run Window
B HQ RSB H-@ - QO Bl BN SIS F oD
|| @@
©  Debug 2 %|=<|# Y= B oV 2 % Bres Peip.. B\ Modu. = B
v n RAM_DA14585 [SmartBond “SmartSnippets DA1468x SDK” via J-Link GDB Server] X = | M~
v B iot58s.elf
) Name Type
v @ Thread #1 57005 (Suspended : Breakpoint)
= main() at arch_main.c:164 0x7fc6528
» JLinkGDBServerCL.exe
wi arm-none-eabi-gdb
5 Semihosting and SWV < >
[4 arch_main.c 53 | [C]00 = 0 B Outline 2 S0

<

&) Console 22

schedule_while_ble_on();

}
while (app_asynch_proc() != GOTO_SLEEP); //grant control to the application, try to

//if the application returns GOTO_SLEEP
//wait for interrupt and go to sleep if this is allowed
if (((!BLE_APP_PRESENT) 8& (check_gtl _state())) || (BLE_APP_PRESENT))

{

//Disable the interrupts
GLOBAL_INT_STOP();

app_asynch_sleep_proc();

/Il ent tha allawsd claan mads

&) Tasks [ Problems () Bxecutables () Memor

RAM_DA14585 [SmartBond “SmartSnippets DA1468x SDK” via J-Link GDB Server] JLinkGDBServerCL.exe
XPSR (1000002, APSR ( EPSR , IPSR

>

on

<

BV o % v
45 ble_is_powered(void) : boo! ~
++% ble_turn_radio_off(void) : void
++° schedule_while_ble_on(void) : v
S ble_validate_sleep_mode(sleep_
4% arch_turn_peripherals_off(sleep,
++3 arch_goto_sleep(sleep_mode._t)
I $ arch_switch_clock_goto_sleep(s
£45 arch_resume_from_sleep(void)
++ s rwip_power_down(void) : sleep,
45 app_asynch_trm(void) : arch_m
>

X% BEREE rB-8-=0

CFBP 00000000, CONTROL 00, FAULTMASK 09, BASEPRI 00, PRIMASK 00
Reading all registers
Read 4 bytes @ address 0x@7F(C0134 (Data = @x4A1A4919)
Read 2 bytes @ address ©x@7F(C@132 (Data = @x00@0)
Read 2 bvtes @ address @x@7FC@134 (Data = ©x4919) M
| Writable | Smartinset | 175:7
Figure 19: Debug Perspective
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8 Creating the Multi-lmage

Detailed information on the provided scripts is included in Appendix C of [1]. Users should use the
script make image iot.bat thatis placed in “..\utilities\mkimage utils scripts”. The .hex
extension is added automatically and the command should be "make image iot.bat 10585". The
output file multi iot585.bin can be used by the Flash Programmer of SmartSnippets™ Toolbox.
Detailed instructions of how to burn the multi-image multi iot585.bin using SmartSnippets™
Toolbox are included in Appendix D.2 of [1].

IMPORTANT NOTE

Because a secondary bootloader is used (Appendix C of [1]) that selects the most recent/valid image
between two images, 10585 .hex cannot be burnt directly into flash, but the multi-image should be created
instead. This functionality is necessary to support firmware updates over the air (SUOTA).
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DRAFT The content of this document is under review and subject to formal approval, which may result in modifications or
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APPROVED The content of this document has been approved for publication.
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